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President Piper’s Ponderings....

| am excited about our May General meeting.
The title is Free Online Learning Opportunities.
Carol and Howard will be talking about a
number of the more popular versions,
generically called MOOCs—Massive Online
Open Courses. The emphasis will be on the free
versions such as edX, Kahn Academy and Ted
Talks. While I'm not privy to exactly what will be
covered, I’'m sure that free courses from
established institutions such as MIT and
Harvard will be mentioned.

Online courses are also available for a fee. This
has given rise to a number of so called “for
profit” universities such as Phoenix and DeVrys;
others specialize in K-12 education. We
probably will not be getting into these examples,
but I think the Club would like to hear any
experiences you or your acquaintances have
had with these institutions. One of the largest,
Corinthians, just went bankrupt earlier this
month.

A couple other related topics that we would like
to hear about your experience include: earning
“Certificates” in computer related topics and

your use of YouTube to learn
about a specific topic. If time
permits, | may also comment
about a couple paid
educational experiences I've
had with Lynda.com and The
Great Courses.

A number of our members proudly pointed out to
me that they still run Win XP, so | stand
corrected about me being the only one. While
the Club takes off for the summer, Windows 10
will be released. So the Board decided that
June’s topic should be on Windows 10. I’'m not
sure what will be said, but we can discuss some
ideas at the May meeting.

We still hope to record our meetings; we may
only get the sound.

| was excited to see such a large turnout at our
April meeting. Come early to get a good seat.

See you Wednesday, May 27 at our General Meeting
(The above comments are the opinion of the
author and do not necessarily reflect the views
of the Midland Computer Club.)

GENERAL CLUB MEETING
Midland Community Center, 2001 George St., Midland MI
Room K111, Barstow Shipps Wing

Wednesday, May 217, 2015
1:00 P.M.
Topic: Free Online Learning Opportunities
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Useful, useless and strange (in no particu-
lar order) Web Sites:

http://askabbystokes.com/

Abby Stokes - computer information, video tutorials,
can sign up for newsletter and follow on Facebook.
Abby is author of book: Is this thing on?

http://www.apcug?2.org

APCUG switched to new website design in May.
Same address. No longer requires sign-in to access
most areas of website.

http://www.youtube.com/apcugvideos

APCUG channel on YouTube for viewing videos
from previous APCUG Virtual Conferences. It may
take a couple months after a Virtual Conference for
the videos to be available.

http://tinyurl.com/lzvpl7j
After reading this article, you may want to take your
computer off the Internet and never connect it again.

http://tinyurl.com/lojfyvv

You may hate those noisy crows in your yard, but
this little girl in Seattle loves them and they bring
gifts to her in return.

http://tinyurl.com/kg8nccj

If you are being dunned for a debt that you know
you do not owe, the Consumer Financial Protection
Bureau may be able to lend you some guidance on
what to do next.

Membership Enrollment Form
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PHONE
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CItYy

EMAIL ADDRESS

Membership dues FAMILY ($20)

STUDENT ($15)

New Member Renewal

Please fill out the above form and mail it along with payment of check or money order to :

MIDLAND COMPUTER CLUB
1816 Bauss Ct
Midland, Ml 48642-4023

Attn: Membership Chairman

You may also pay for membership at a regular club meeting
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Tips, Tricks & Techniques

Midland Police Department Lobby available for social media transactions

(Midland Daily News April 16, 2015)

The Midland Police Department is making its facilities available for social media transactions, such as
Craigslist or Facebook. Citizens may meet in the lobby of the Law Enforcement Center during regular
business hours (8am - 5pm Monday through Friday) and anytime in the parking lot. The LEC is located at
2727 Rodd St.

Google introduces new Chrome devices

Google introduced two new Chromebooks for $149.

Amazon - Haier Chromebook 11: http://www.amazon.com/dp/BO0V3DYVLM (available for pre-order)
Walmart - Hisense Chromebook (11.6" Quad-Core Processor): http://www.walmart.com/ip/44389793

Google also introduced a new kind of Chrome OS computer, the Chromebit which they are advertising as
a device that turns any TV into a Chrome PC for under $100. It is a dongle that plugs into any
HDMI-equipped display, swivel base, 2Gb RAM, 16Gb solid state storage and single full-size USB 2.0
port.
http://mashable.com/2015/03/31/chromebook-chromebit/
http://chrome.blogspot.com/2015/03/more-chromebooks-for-everyone.html

Above are scheduled to be available summer 2015.

Intel Compute Stick - Windows on a dongle

The Compute Stick is made by Intel and has an Atom Bay processor. This device is also advertised as

converting almost any HDMI enabled device into a computer. There are two versions (Windows or Linux)

that were expected to be released in March 2015.
http://www.gizmag.com/intel-compute-stick-windows-dongle/35523/
http://www.cnet.com/products/intel-compute-stick/
http://winsupersite.com/mobile/ces-2015-intel-compute-stick-provides-windows-81-bing-hdmi-dongle

According to the above CES articles, Intel will be selling the compute stick directly to buyers. Amazon lists
several Windows on-a-stick products but based on reviews they appear to be from questionable suppliers
and may include non-licensed copies of Windows with bundled programs in the Chinese language. If you
are considering one of these devices, make sure to avoid off-brands.

A full Windows PC for $35?

Windows 10 coming to Raspberry Pi 2: Later this year, Microsoft is handing Windows 10 out free to the

Maker community through its Windows Developer Program for IoT.
http://www.theverge.com/2015/2/2/7962179/raspberry-pi-windows-10
http://blogs.windows.com/buildingapps/2015/02/02/windows-10-coming-to-raspberry-pi-2/

Dodged a bullet

While searching websites for this article, | was reminded that no matter how cautious one thinks they are
being, the unexpected can happen. While viewing what appeared to be a reputable site, | highlighted and
copied the url of the website to paste into this document. After completing the Paste, instead of the
expected url, several lines of text appeared in the document. Deleted the pasted text from the document.
Returned to the browser and was presented with a professional looking security warning which | quickly


http://www.amazon.com/dp/B00V3DYVLM
http://www.walmart.com/ip/44389793
http://mashable.com/2015/03/31/chromebook-chromebit/
http://chrome.blogspot.com/2015/03/more-chromebooks-for-everyone.html
http://www.gizmag.com/intel-compute-stick-windows-dongle/35523/
http://www.cnet.com/products/intel-compute-stick/
http://winsupersite.com/mobile/ces-2015-intel-compute-stick-provides-windows-81-bing-hdmi-dongle
http://www.theverge.com/2015/2/2/7962179/raspberry-pi-windows-10
http://blogs.windows.com/buildingapps/2015/02/02/windows-10-coming-to-raspberry-pi-2/
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determined was fake. Clicking either the Cancel button, or X in upper right corner of the warning page,
kept me in a loop of repeating warnings. Could not close the browser and could not access Task
Manager. Held down the power button to force the computer to shut down. Computer restarted normally
but slower than usual so was anticipating the worst but the desktop finally appeared and everything
looked okay. Malwarebytes was already installed so immediately updated and ran it. While it was running,
checked Control Panel - Uninstall a Program, to make sure no new programs had been installed.
Malwarebytes completed with no problems detected. Then ran TDSSKiller which did not detect any
issues. Opened the browser, deleted the last hour of History and checked to make sure no new browser
extensions had been installed. Ran a full antivirus scan using the currently installed antivirus. While that
scan was running, located the programs from President Piper’s April presentation, just in case. However,
for now, everything seems to be running okay but will be watching the computer closely.

| recently received a newsletter from someone who has been in the computer industry for 55 years and he
admitted he became a victim of another type of attack. He received an email that appeared to come from
a local retailer, but, when he clicked on the attachment, his computer was infected by ransomware, which
totally disabled his system. Fortunately he had a recent disk image and incremental backups so he was
able to restore his system without losing any data. The spammers are getting more sophisticated, making
it harder to distinguish fake emails and webpages. They also hide their malicious code in ads that appear
on reputable webpages.

We continue to see media reports about people having their computers compromised and/or giving out
credit card or bank information when someone calls offering them a support contract or telling them there
is a problem with their computer. Howard received a call this week, supposedly from Microsoft. Scammers
are also targeting owners of Macintosh computers. No matter how often these scams are mentioned in
the media, people are still being victimized. Tell your family and friends about these scams and that they
should hang up if anyone calls telling them there is a problem with their computer. Remind them to never
give anyone remote access to their computer, unless they know the person or have initiated the call to a
known/reputable support person/company.

ARTICLE INDEX

Control Layout in Word with Page Breaks -- Page 5

Nancy DeMarte, 1st Vice President, Sarasota Technical User Group, FL
Windows 8/8.1 Corner - Customize the Text on Your PC -- Page 7
By Rosita Herrick, Yahoo Forum Moderator, Sarasota Technology User Group, FL
Fun and Knowledge with YouTube -- Page 9

By Jim Cerny, 2™ Vice President, Sarasota PCUG, Florida

Interesting Internet Finds -- Page 10

Steve Costello, Boca Raton Computer Society

Music and Video Files: Modify them to your needs -- Page 11

By Phil Sorrentino, Contributing Columnist, STUG, FL

Review of the WOW! Computer -- Page 12

By Jon Mazur, President, CPUser Group, PA, http://cpusergroup.apcug.org,

My eBay for Seniors -- Page 15

By Michael Miller, Que Publishing

Articles in this Newsletter have been obtained from APCUG with the authors’ permission for publication
by APCUG member groups. The Midland Computer Club has not verified the information contained in
the articles nor tested procedures or hardware/software. Articles do not necessarily reflect the views of
the Midland Computer Club.
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Control Layout in Word with Page Breaks
Nancy DeMarte, 1st Vice President, Sarasota Technical User Group, FL
September 2014 issue, Sarasota Technology Monitor, www.thestug.org, ndemarte (at) Verizon.net

Most of us don’t write books or lengthy treatises. But now and then we use our computers to write
multipage documents like newsletters, articles, and reports. Microsoft Word offers special tools to assist in
keeping text where we want it to be in longer documents. Among my favorites are the various tools for
controlling where one page or a section of a page ends and the next begins: the Breaks tools. This article
explores the Page Break tools. Next month’s article will deal with Section breaks. There are times when
you want the next part of a document to begin on a new page, such as the body of a report after an
introductory section. Rather than pressing the Enter key several times to get to the next page, the Page
Break tool lets you end the introduction wherever you want to on one page and begin the body of the
document on the next. Because the Page break tool holds the break in place, you can return later and add
text or a graphic to the introductory page without disturbing the text on the next page. Word has always
had a Page break tool, but many home users don’t bother with it. Learn about its functions and you'll see

its value.
el — L
Tl r—’}_’ IL’ lgg' ' Breaks - The Breaks tools are found on the Page Layout tab
E=T ’,7.\ ; .= T[] Line Numbers * in fche Page Setup group iq Wor.d 2013, which | am
Margins Orientation Size Columns A using as the example in this article. In older
v v v v bc Hyphenation ~ versions, the Page break tool is on the Insert menu.
Page Setup M

FiguPagé Set-Bpegksupgool s

Ll -
*— Breaks v Indent Spacing
Click the down arrow to the right of Breaks to see the

three Page break options. To use the Page break tool, | 29 8reaks

click at the end of the last word (plus punctuation) that | 1 @

you want to leave on the current page. Then click the P~  Waricthe point at which one page ends
Page break icon. This ends the page at that spot and [ 7] and the next page begins.

moves the following text to the top of the next page. | o

use this tool so often that | have it in my Quick Access D Column , ,
toolbar above the ribbon where it is always handy. Indicate that the text following the column

break will begin in the next column. §

I Text Wrapping
Separate text around objects on web
pages, such as caption text from body text. )

FiguPag2 break tool s

Sometimes page breaks can cause unexpected results. For example, editing a document after inserting a
page break can result in a blank page in the middle of the document. Deleting the break will eliminate the
blank page, but in normal view, the page break indicators are not visible. To make them visible, turn on
the Show/Hide tool (Home tab — Paragraph group — Paragraph symbol). The Page break indicator is a

Draft-(View-tab-—Views-group— Draft)-or-turn-on-the-Show/Hide-tool-(Home- | horizontal dotted line with

. _ g . ) ) o _ | the phrase, Page Break, in
pup-—Paragraph-symbol).-Being-able-to-see-where-your-breaks-are-is-helpful the middle. To delete a page

).deleteorchangeone .............................................. Page Break}] break’ drag over the dotted
line to highlight it, then press
FiguPag8 break indicator Backspace or Delete.

The Column break tool works the same way as Page break, but its purposes can be different. If you have
formatted your document into two columns, for example, you can add a column break at any spot in the
first column, which will move all the text after the break to the top of the next column. Often this is done to
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make columns more even in length. This tool is useful in a newsletter when you want an article with two
equal length columns extending partway down the page, making room for a photo or second article below

If you create documents on a regular
basis, it is very easy to lose track of
when they were written and where
they are saved. Having a standard
footer along the bottom of each page
can help you remember when you
created the document, which page it is
of along document, and even where
it’s located on your computer. In Word
2007 and later, you can easily create a
custom footer which includes the
information you want and save it in a
handy spot called the Building Block
gallery. Here is how it's done.

For illustration, | chose to create a
footer which includes the date the
document was created and the file

Insert tab in the ribbon, Quick Parts —
Field. I scrolled down the list and
clicked “FileName.” | chose lower case
for its format, and checked the box
which said, “Add path to filename.”
When I clicked OK, the entire path
appeared in the footer.

If you create documents on a regular
basis, it is very easy to lose track of
when they were written and where
they are saved. Having a standard
footer along the bottom of each page
can help you remember when you
created the document, which page it is
of a long document, and even where
it's located on your computer. In Word
2007 and later, you can easily create a
custom footer which includes the
information you want and save itin a
handy spot called the Building Block
gallery. Here is how it’s done.

For illustration, | chose to create a
footer which includes the date the
document was created and the file

[romputer. First | opened a document |
had saved, clicked the Insert tab, and
then Footer. From the list | chose the
footer labeled, “Blank (Three Column)”
since | was adding three pieces of
information. | then scrolled to the
footer at the bottom of the page and
made sure my cursor was flashing
inside the footer area. First |
highlighted the left placeholder and
pressed Delete to remove it. Leaving
my cursor in that spot, | clicked the
Insert tab in the ribbon, Quick Parts —
Field. I scrolled down the list and
clicked “FileName.” | chose lower case
for its format, and checked the box
which said, “Add path to filename.”
When | clicked OK, the entire path

name, including the path you would

appeared in the footer.
need to follow to locate it on your R

name, including the path you would
need to follow to locate it on your
computer. First | opened a document |
had saved, clicked the Insert tab, and
then Footer. From the list | chose the
footer labeled, “Blank (Three Column)”
since | was adding three pieces of
information. I then scrolled to the
footer at the bottom of the page and
made sure my cursor was flashing
inside the footer area. First |
highlighted the left placeholder and
pressed Delete to remove it. Leaving
my cursor in that spot, | clicked the

Fi guEwverm col

break

umns

Figubeeden col umns

To add a column break, click at the beginning of the line you want to move to the top of the next column.

created

us

Choosing the correct line sometimes takes a few tries to get the even column effect you want. The column

break indicator looks like a page break indicator and is deleted the same way.

The third tool in the Page break group is the Text-wrapping break. Although intended for web pages, it
can be helpful in Word documents. If you have added a photo, table or other object to a document, and

would like to put some text, like a caption, around or below the

object, this break option can hold it in place better than using the vy (eEaE | 2|
Enter key or adding a text box. More information on text-wrapping = . o
will be found in a future article. Word has another set of options = ==&V | T
relating to page breaks: the Line and Page Breaks options found on

the Home tab — Paragraph group in the dialog box. Click the faiagtaph L

diagonal arrow in the bottom right corner of the Paragraph group to box i ndaT

see this box.

Fi gutDeé a6 og

Next click the Line and Page Breaks tab to see the options, which have been part of Word through many
N x | editions. Understanding them can help you solve formatting
problems. The first one, Widow/Orphan Control, selected
by default, prevents a single line of a paragraph from being
left alone at the bottom or top of a page. Word will
automatically move the paragraph to the next page rather
than leave even a one word line by itself. (Hence, the tool’s
name.) Since this action can sometimes leave more blank
space at the bottom of the page than | want, | often shorten
Br ethexparagraphda keep Widow/Orphan control from taking
effect.

Paragraph

Indents and Spacing

Pagination
[] Widow/Orphan control
[7] keep with next
[] Keep lines together
["] Page break before

FiguLenéd and Page

The next option, Keep with next, ties the current paragraph to the following one. Keep in mind that in
Word, any time you press Enter, a new paragraph is created. Therefore, this option helps keep a heading
with the paragraph it relates to, rather than leave the heading at the bottom of one page and its related
paragraph on the next. Keep lines together simply keeps all lines of a paragraph together on the same
page. You can see how that might add a lot of blank space in a document. The last option, Page break

cator
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before, inserts page breaks so that each paragraph in a document will begin at the top of a page.
Generally, these three options are only useful in special situations. To enable one, click its checkbox -
OK. If you want any of them always to be in effect, also check “Set as Default” at the bottom of the dialog
box.

Word offers ways to control many more aspects of a document than most of us realize. Getting to know
what the options are can give us more tools to use when we need them.

Windows 8/8.1 Corner - Customize the Text on Your PC
By Rosita Herrick, Yahoo Forum Moderator, Sarasota Technology User Group, FL
http://thestug.org/, Rosita (at) thestug.org

Font sizes:

If the default size of text on your PC, especially on laptops, is small and hard to read, here are the steps
to increase it.

Right click on any empty part of the desktop wall paper

View »
Sort by >
Refresh

Paste
Paste shortcut

EB nvIDIA Control Panel

=]

Shared Folder Synchronization r
Next desktop background

New 4
B8 Screen resolution ‘»—_—
& personalize

Click on Screen resolution and the click on Make text and other items larger or smaller.

Change the appearance of your display

Detect

Identify

Display: 1. NEC MultiSync P221W v
Resolution: 1680 = 1050 (Recommended) v
Orientation: Landscape v

Advanced settings

Make text and other items larger or smaller b

What display settings should | choose?
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On this new window there are a few choices:

Change the size of all items

Make text and other items on the desktop smaller and larger. To tempaorarily enlarge just part of the screen,
use the Maagnifier tool.

() Srmaller - 100%

(@ Medium - 125%

() Larger - 150%

Custom sizing options

Let me choose one scaling level for all my displays

Change only the text size

Instead of changing the size of everything on the desktop, change only the text size for a specific item.

Title bars 11 Bold

1. If you use one scaling level, some items might be different sizes on different displays. Apply

You'll see this change the next time you sign in.

You can click on the checkbox and get the choice of size you want to increase for all items or
leave the box blank, and as shown below, change the font of specific items

In the Items box | chose Menus, checked the Bold box, and then checked Apply

Change only the text size

Instead of changing the size of everything on the desktop, change only the text size for a specific item.

Menus v |9 v [v]Bold b

Apply | o

Here are the before and after results:
B Pict
i Pictures =~ Ietures View 4
7 - 3
View ’ Videos Sort by
Videos Sortby ’ = Group by 4
- Group by 4
Refresh Refresh
Paste Paste
Paste shortcut Paste shortcut
New 4 New 3

Reminder: Don’t forget to click on the Apply box to finalize the change.
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Fun and Knowledge with YouTube
By Jim Cerny, 2™ Vice President, Sarasota PCUG, Florida
February 2014 issue, PC Monitor, www.spcug.org, jimcerny123 (at) gmail.com

Whether you have a tablet, smart phone, or any kind of computer, YouTube is one application that can,
all by itself, really justify the purchase of your device. YouTube can be found on the internet at
youtube.com (that’s easy to remember, right?) or you can download the free YouTube application for any
device. Since Google has acquired YouTube, it can also be found on the Google web site (it used to be
Google videos).

YouTube is your access to millions of videos made by almost anyone who wants to make them available
to you for free. Many of the videos are fantastic and some are just a waste of time. But YOU decide. You
search for the videos you want to see simply by entering your search criteria (regular English words) in
the search box. Do you have a favorite entertainer? Just enter their name and you will have access to
hundreds of their videos. How about a home improvement project? Just enter what it is you want to do
and see a video of how to do it. AlImost anything you can think of, there is probably a video on that subject
on YouTube.

Here are just a few examples of fun things to see and explore on YouTube: Famous people, science
experiments, college lectures, cartoons, news, products, companies, cooking, travel, painting, and, well
just about everything.

The only thing it seems that YouTube does not give you is fairly recent free movies and TV shows. If you
searched for a movie or TV show by its title, YouTube will probably only show you the “trailers” for free.
However, YouTube does offer some movies and TV shows for a price. But the real fun for me is seeing all
that is available to you at no cost whatsoever — and you do not have to join anything.

You could think of YouTube as the ultimate “window to the world” and all that is in it by just using your
computer or device. Why read a printed article or view pictures? YouTube can SHOW you what other
sources only TELL you. Click on the right-pointing arrow to play the video. You can click on any point on
the progress bar to go to that point in the video. And you can click on pause (usually the double vertical
line symbol), just like you used to do with the old video VHS tape players. After clicking on “pause” you
can go back to the list of videos just like you do with Google. Some videos may have a short
advertisement the plays before the real video starts.

There is really no limit to what YouTube has to offer. | have yet to search for something that did not have
some kind of video to watch on that subject. So do not limit your imagination either. Here are just a few
things | have found — each of which can provide hours and hours of videos:

Enter your favorite game and learn how to play the game or sport better.

Enter “How to...” and learn a new skill or improve the skills you have.

Tour your favorite city, park, or attraction.

Ride all the roller coasters you want, at any park, and never have to wait in line or get dizzy.
Attend a class lecture at a famous university.

View long-forgotten videos of famous people and entertainers.

View videos of how to use your digital camera or tablet or any device or contraption.

See dangerous stunts, magic tricks, and stupid jokes.

Discover new things about your favorite hobby.

= =8 -8 -_8_-8_-4_-48_-9._-2

So don’t hold back — be adventurous and explore the world! Your brain will thank you for it.
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Interesting Internet Finds
Steve Costello, Boca Raton Computer Society
editor@brcs.org, http://ctublog.sefcug.com/

In the course of going through the more than 300 RSS feeds, | often run across things that | think might
be of interest to other user group members.

The following are some items | found interesting during the month of June 2014.

How can | manage a lot of scanned documents?
http://askleo.com/how-can-i-manage-a-lot-of-scanned-documents/
Leo Notenboom explains how he manages a lot of scanned documents. Check this post out to
get an idea of how to handle your own collection of scanned documents.

How to Record Screencast Videos on Android
http://www.labnol.org/software/record-android-screencast/4929/
Have an Android and thinking about recording screencasts with it? If so, you should read this
post first.

How to Make a YouTube Video Easily

http://www.aha-now.com/how-to-make-a-youtube-video/
Another interesting post, this time about how to easily make a YouTube video. This post
explains how you can create your own YouTube video without a lot of specialized equipment
and lighting.

Is Your PC Updating Correctly? Are You Sure?
http://www.techsupportalert.com/content/your-pc-updating-correctly-are-you-sure.htm
You're updating your Windows PC all the time. Are you sure the updates are actually being
done? Gizmo's Freeware tells you how to check in this post. | think this is something you
should do periodically. In fact, the post reminded me to check my Windows machines. They all
checked out, giving me some peace of mind.

Going Paperless Quick Tip: Clipping Email with the Evernote Web Clipper
http://www.jamierubin.net/2014/06/17/going-paperless-quick-tip-clipping-email-with-the-evernote-
web-clipper/
In this Going Paperless tip, Jamie shows how to clip your email into Evernote using the Web
Clipper. | found the tip useful, and thought you might also if you use Evernote and email.

6 Tips to Help You Go Paperless On Android
http://www.makeuseof.com/tag/6-tips-go-paperless-android/
This MakeUseOf post explains ways to be paperless on your Android, by scanning receipts
and documents, using a notekeeping app, printing to PDF, and more.

*hkkkkkhkk

Most Fridays, more interesting finds will be posted on the Computers, Technology, and User Groups
Blog: http://ctublog.sefcug.com/tag/interesting-internet-finds/

The posts are under Creative Commons licensing.
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Music and Video Files: Modify them to your needs.
By Phil Sorrentino, Contributing Columnist, STUG, FL
June 2014 issue, PC Monitor, www.spcug.org, philsorr (at) yahoo.com

Music and Video files that you produce with your video camera, or voice recorder, are not always exactly
what you want. Now, I'm not suggesting that you can change the artistic quality of the file, but that you can
change the file length or size to accommodate your particular needs. With either an audio or a video file,
the particular file may be too long, or it may contain sections that are not needed. So, it would be nice to
be able to cut off the beginning, the end, or remove a slice somewhere in between. I’'m sure there are
many other ways to accomplish these tasks, but | have found that Windows Movie Maker (to modify video
files) and Audacity (to modify audio or music files) are good choices, and both of these software
applications are free. Windows Movie Maker is provided by Microsoft and can be downloaded at
windows.microsoft.com/en-us/windows/get-movie-maker-download, and Audacity is provided by
Sourceforge and can be downloaded at http://sourceforge.net/projects/audacity/?source=directory.

A multi-media presentation, or “movie” as Movie Maker (and many other commercial packages) calls it, is
a collection of pictures, videos, and music, organized as a movie, used to tell a story. It may be the story
of your latest vacation, your last birthday, the last big holiday, your youngest grandchild, or a pictorial
history of someone, something, or some organization. If you have appropriate pictures, videos, and music,
Movie Maker can easily put them together to create a movie to express your particular point of view. So,
obtaining the pictures, videos and music is usually the first step in producing your movie. Pictures are
probably the easiest; you just review the pictures, improve their quality if needed, and then put them is an
appropriate sequence. Videos are a little more difficult because they usually need to be shortened, and
possibly have inappropriate sections removed. Music, or audio, is easy if you have good recordings, but
sometimes you may want to remove certain portions, like bad scratches or pops, or a long lead-in or long
lead-out. Or you might only want a few words out of a lengthy oration.

Movie Maker can be used as a tool for modifying video clips. (Once the video clips are the way you want,
you can then add them to your movie.) After opening Movie Maker, click “add videos and photos”, and
navigate to the video clip that you want to modify. Select the video clip and it will be added as the only
item in your movie. The video clip will be imported and shown as a series of Video blocks. Now you can
play your video clip using the Play and Pause buttons, and identify the pieces to be removed. Select
“Edit”, under Video Tools, and you will see the “Split” tool. Move the Movie Cursor (the dark vertical bar) to
the first point where you would like to split the video. If you are going to remove the beginning, move to
the point where you would like the video to begin. Click the Split tool. This will create two videos, one
before the split and one after the split. Right click the video piece to be removed and select “Remove”.
This will delete that piece of the video. Now you can move through the video and identify pieces to
remove and pieces to keep. Just move the Cursor to the locations to split the video and use the Split tool.
Then Remove the unwanted pieces and save the good piece as a new video with a new name. Usually
you will find pieces to keep and pieces to remove interspersed. If you want to save many pieces, you will
probably have to find a piece to save and delete everything else, and then start over with the original
video and isolate the next piece and delete everything else. So it may be very tedious if you want to save
a lot of small pieces from one larger video, but it will surely be worth the time and effort. Once you have
video pieces, you can join them by starting with a “File-New” movie and adding the video pieces using
“add videos and photos”. Put them in the proper sequence and add a “transition” in between so they will
flow smoothly, then save it as a new video.

Audacity is an Audio Editor and Recorder. Audacity is very comprehensive and can do many things. One
of those things is that it can be used as a tool for modifying audio (sound or music) files. After opening
Audacity, click File-Open and navigate to the audio clip that you want to modify. The audio clip will be
imported and shown as a graph of the amplitude of the audio. (Both Left and Right channels will be
displayed if the audio is in stereo). Now you can Play your clip using the Play and Pause buttons and
identify the pieces to be removed. No, or very low, volume periods will be indicated by just a horizontal
line with no amplitude. The Audio Cursor can be placed on the recording by Right-clicking on a point in


http://windows.microsoft.com/en-us/windows/get-movie-maker-download
http://sourceforge.net/projects/audacity/?source=directory
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the recording. A section of the recording can be selected by pressing the Right Mouse button while on the
recording, and dragging the Mouse to the end of the area to be selected. Then using the File-Export
Selection, the selected section can be saved as a new audio file with a new name. | found this tool very
helpful in separating multiple cuts from an audio recording of a complete side of a vinyl recording (a
record album for those of us over 40). | had converted my old vinyl recordings to .mp3 files, just before
giving them away. To save time | converted the recordings a side at a time. So for each vinyl album |
ended up with two .mp3 files, each about 20 to 25 minutes, and each having 12 to 16 cuts (songs) in
each .mp3 file. So, the individual songs were separated by about 2 seconds of silence (no amplitude),
making them easy to identify, once you have listened to the cut using Audacity.

As you can see from these basic directions for modifying a video file with Movie Maker and an audio file
with Audacity, the process is very similar, even though the displays look very different and the displayed
file representations look very different. The results are very similar too; it's a modified file that will be
useful in your next Movie Making project.

Review of the WOW! Computer

By Jon Mazur, President, CPUser Group, PA, http://cpusergroup.apcug.org,
Cpusergroup (at) hotmail.com

How many of you think computers are still hard to use? Well | think | have the answer for you. | recently
had the chance to review quite possibly the world’s easiest computer, from setup to actual use. I'm talking
about the WOW! Computer from FirstStreet. My 72 year old brother was actually looking to purchase a
new computer and had asked me to do a little research on computers that would be easy for him to use. |
stumbled upon the WOW and suggested he check out some videos | found for him online. After a few
back and forth discussions with him, he decided to go for it. He got in to computers in 1995 and after 12
years of frustration using Windows, he had me convert his two other machines to Linux and he has never
looked back. The reason that | mention Linux is that the WOW actually runs a custom version of Linux
called Tiny Core Linux. After he found that out it was a no brainer.

WOW! Good Morning!
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Here are some highlights of the WOW! Computer:

1 Innovative touch screen design - one finger can control everything! (even comes with a stylus
so you don’t smudge the screen)

Easy setup -- just plug in the power and your high-speed Internet connection & you're online
Email is easy with large print and simple instructions

One-touch access to many popular web sites plus simple browsing to the rest of the Internet
Built-in video (Skype) chat, games, calendar, and much, much more!

T NEW! Text-to-voice reads your email to you
COMING SOON! Voice dictation; speak your emails instead of typing

T
T
T
T

Once my brother received his computer it took no more than 10 minutes for him to set it up and he had it
working and online in about 15 minutes and he is not that computer savvy. The computer, as mentioned
before, runs Linux but has a custom front-end interface that is truly user friendly. See the above photo
which is what you see when the unit is powered on. The use of email, web surfing, video chatting, photo
viewing, CD/DVD playback and much more are all included. Other key points to keep in mind are listed
below.

27-year old U.S. based company (Virginia)
1-month risk free trial (no questions asked)
Lifetime tech support (phone and remote access)
U.S. based tech support

No hidden fees

No sales tax (at least not in Pennsylvania)
$50 shipping charges

Free HP printer (-$50 if you already have one)
Easy setup

Closed ended software system

Runs Linux operating system

Company handles all updates

Cost $1079 with the printer or $1029 without
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Product Specifications:
CPU - Intel® 847 Celeron Dual Core Processor
Monitor - 22" High Definition, 16:9 widescreen panel (1920 x 1280 pixels)
Touch Panel - Multi Touch Screen
Graphics Card - AMD® Radeon™ HD 6310 Discrete-Class Graphics
Memory - 2G DDR3 / DDR3 SO-DIMM x 2 Slots
Wireless LAN - 802.11 b/g/n
Hard Disk Drive - 500GB 3.5" SATA Il
Optical Drive - Tray-in DVD Super Multi (plays CD’s too)
Speaker - Two built-in, front-facing 3W Stereo Speakers with SRS Premium Sound Technology
Webcam - Built-in 1.0 MP Webcam and Microphone
Rear Input/Output - 4 USB 2.0 ports, 1 microphone in, 1 earphone out, 10/100/1000 LAN jack
Side Input/Output - 6 in 1 memory card reader, 4 USB 2.0 ports(one with super charger), 1 DC jack
Power - 65W AC Adapter
Wired Keyboard/Mouse - Keyboard and Mouse included
Supports HP printers only (for now)
Dimensions - 22" W x 16 3/8" H x 10 1/8" D (including space needed for stand)
One year hardware warranty

Conclusion:

This is truly a great computer for those of you who are tired of the Windows or Mac rat race or who just
want to simplify your computing life. My brother, for the first time in many years, truly is enjoying using his
computer. A couple of things to keep in mind. The computer uses a closed ended software system.
Meaning you cannot install any software on it yourself. So if this is something that you like to do, then this
system is definitely not for you. Also the cost of the computer is $1079 with the printer or $1029 without.
This may be a little steep for most people but keep in mind that you are getting lifetime tech support that is
U.S. based. In closing | would say that this is a system that is pretty much maintenance and worry free.

You may contact me at cpusergroup@hotmail.com if you need further info on this system or visit the
FirstStreet website at: http://tinyurl.com/Ices9wu



http://tinyurl.com/lces9wu
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My eBay for Seniors

By Michael Miller, Que Publishing

Review by Melvin Weekley, Editor, Seniors Computer Group, CA
Miweekle (at) cox.net, www.SCGsd.org

Rating: 5 Stars
Excellent resource for the beginner and the experienced user

This is an excellent book, the best | have seen on the subject of using eBay.

What | like the most is the organization of the subject matter and the indexes. The table of contacts has
an excellent list of the topics that will interest most readers and you can read about a topic that is of
particular interest or just read through the book.

The index is quite thorough and is easy to find the particular topic you wish to read about.

The content of the book is very thorough and written in a style to appeal to all level of readers. A person
just starting to use eBay will find it extremely helpful in guiding them through the process of learning and
using eBay. The experienced reader can jump quickly to the particular topic they wish to learn more about
and get the details they need.

The book also has excellent charts of the various items included in each area and makes it simple and
quick to find what you need.

I would recommend this book to anyone from the one considering trying out eBay to the experienced user
just wanting a quick reference to details of using eBay.

eBay




